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ABOUT GEOCUE GROUP, INC. 

GeoCue Group was founded in 2003 by a group of engineers with extensive experience in developing 

hardware and software solutions for primary remote-sensed data acquisition. Our initial products were 

aimed at reducing schedule and cost risk in geospatial production workflows by providing 

organizational, productivity and data management tools for base geospatial data production. These 

tools have been realized as the GeoCue product family. Today GeoCue workflow management tools are 

used by a majority of North American geospatial production shops. In 2005, GeoCue began selling and 

supporting Terrasolid tools for kinematic LIDAR data production. This was followed in 2009 by our 

acquisition of QCoherent Software LLC, the creator of the point cloud exploitation toolset, LP360. 

Today GeoCue is the largest supplier of kinematic LIDAR processing tools in North America and LP360 

is the world’s most widely used tool for exploiting point cloud data. In 2014, GeoCue Group started a 

division focused on using small Unmanned Aerial Systems for high accuracy mapping. Leveraging our 

expertise in production, risk reduction, and point cloud processing tools, we are continuing to bring new 

services and products to market to provide surveyors and other geomatics professionals exciting tools 

for geospatial data extraction using low cost drones including Loki, our plug-and-play PPK direct 

positioning system, and now our new True View LIDAR/Imagery fusion sensors. To learn more, visit 

www.geocue.com. 

  

http://www.geocue.com/
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ABOUT TRUE VIEW EVO 

True View Evo is a 64-bit Windows® desktop application used for processing and exploiting True View 

sensor data. It is GeoCue’s LP360 point cloud exploitation product with the addition of a collection of 

tools for True View sensor data workflows. Currently, True View Evo is available in two licensing levels: 

• True View Evo – This is equivalent to LP360 Advanced with the addition of the True View 
workflow tools.  It is limited to product areas of no more than 4 km2 of LIDAR data 

• True View Evo Unlimited – this is the same functionally as True View EVO but the size limit is 
removed.   

True View EVO is the software used to post-process your raw flight data. EVO will generate a 3D LIDAR 

point cloud in LAS format, colorize the point cloud, and geotag the images collected. It is based on 

GeoCue’s LIDAR point cloud exploitation software, LP360, and comes with all the same tools as LP360 

Advanced. Tools such as accuracy assessment, automatic and manual ground classification, and 

contour/ surface exporting.  

ABOUT TRUE VIEW RECKON 

True View Reckon is an Amazon Web Services (AWS) hosted platform that is used for a variety of 

purposes in True View (and other) workflows.  It provides services such as (items marked with a $T are 

extra cost, paid in True View Points): 

• Project data hosting and visualization ($T) 

• Data archival ($T) 

• Management and automatic delivery of sensor calibration files 

• Automatic sensor health check 

• Transfer of sensor Cycle data to GeoCue for technical support 

• Management of True View Points for services that are paid via a metering scheme (marked in 
this list with $T) 

• Transaction history of sensor usage 

• other related services  

True View Reckon is accessed from within True View EVO in various workflows.  These workflows might 

require a True View Evo user to provide their Reckon login credentials.  True View Reckon also has a 

web interface for data visualization and account monitoring. 

Every customer with a True View sensor (whether purchased or subscription) is provided a Reckon 

account. 

A TRUE VIEW CYCLE 

All True View sensors write their various data streams to a standard file folder structure called a “Cycle.”  

The original meaning of cycle was an on/off cycle of the sensor.  It is possible to have multiple 

collections (flights, in the case of a drone) in a single Cycle, so it is not necessarily correct to think of 

cycle as being synonymous with a flight.  

https://support.geocue.com/lp360-2019-1-feature-matrix/
https://support.geocue.com/lp360-2019-1-feature-matrix/
https://support.geocue.com/lp360-2019-1-feature-matrix/
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LICENSING AND INSTALLATION 

When your True View system is purchased or a subscription is to begin, your company’s point of contact 

should receive an email from support with instructions for downloading the latest version of True View 

EVO from the GeoCue FTP. A username and password for the FTP should be provided in the email, 

along with your EVO License String. Download the latest version of EVO from the FTP and copy to a 

local drive on your computer. Double-click on the installation file to install EVO. Once installed, use the 

steps below to activate EVO using the License String provided in the email. 

Note: It is necessary to enable outbound communications to TCP ports 5053, and the customer specific port 

outlined in your EVO licensing email, on any firewalls for the product to communicate with the hosted 

license server. These ports are normally open by default on most firewalls.  

LICENSING TRUE VIEW EVO  

1. Open True View EVO and select File -> License Manager 

a. If your version of EVO is currently unlicensed, you will get an error and be prompted to 

open License Manager when you try to open EVO. 

2. On the Activation tab, copy and paste the License String into the License String field. 

3. Select “Set” to set the License String. 

a. If you encounter an Invalid License String Error message, see the probable resolutions 

on our searchable support knowledge base. 

4. The Available Licenses portion of the license manager should now be highlighted. Select the 

dropdown to select the True View EVO license. 

5. Select Check out floating license to use your floating license. An Internet connection must be 

maintained while using a floating license. 

a. If you need to use the license without internet connectivity, check the box to roam the 

license, and then check out the license. A license can be roamed for up to 30 days. 

Other users with access to this license will not be able to use it while the license is 

roamed. 

6. The Current License portion of the dialog should now show the license type with a green check 

mark (Figure 1) indicating that the EVO license has been activated. 

 

Figure 1 - License Manager 

7. The license is now activated, and EVO can be used for processing.  

True EVO license comes standard with a floating license, which means the license can be shared easily 

within your organization. Just install EVO on all the machines that need to use the software, then 

https://support.geocue.com/invalid-license-server-string-error/
https://support.geocue.com/invalid-license-server-string-error/
https://support.geocue.com/invalid-license-server-string-error/
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repeat steps 1-6. Only one machine can use the license at a time. The license can be checked in and out 

as needed if it is not in use by another machine. 

POSPAC CLOUD VS LOCAL PROCESSING 

True View EVO uses a built-in interface that runs the POSPac processing solution to provide GNSS and 

inertial corrections. POSPac can be run by one of two methods: Cloud or local. Cloud processing 

uploads your data to an Applanix server, corrects the data, and downloads the processed results. Local 

processing runs a locally installed version of POSPac in the background on your machine and does not 

use True View Points.  

CLOUD 

Cloud processing uploads your flight data to an Applanix server which corrects the GNSS signal and 

inertial values stored in the T04 file. The smoothed best estimate trajectory (SBET) is then computed 

and downloaded back to your local machine. The user is charged True View Points based on the 

number of kinematic minutes for the processed files. This trajectory is then used to geocode your 

LIDAR data. Customers with a True View subscription system, or those with an owned system who wish 

to process the trajectory using SMARTBase or PP-RTX, can only use the cloud processing option. 

Owned systems also have the option of single base processing using the Cloud. Any use of the 

POSPacCloud processing must have enough True View Points available to cover the cost of processing 

regardless of the business model for the system. The steps below explain how to configure EVO for 

POSPacCloud processing.  

INSTALLING POSPAC CLOUD 

1. Download POSPacCloud from the GeoCue FTP using your company’s login credentials 

provided in the license email.  

2. Unzip and double-click the POSPac cloud executable to install.  

3. Open EVO, click File, then Project Settings. 

4. Click the True View tab and verify that the POSPac cloud executable is selected in the 

POSPacCloud.exe Location (Cloud) field (Figure 2). 

5. If it is not auto selected, navigate to C:\Program Files\Applanix\POSPac Cloud and manually 

select POSPacCloud.exe.  

https://support.geocue.com/single-base-vs-smartbase-vs-pp-rtx/
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Figure 2 - POSPacCloud Executable Settings 

ADDING A COMPANY TO EVO 

EVO communicates with True View Reckon Portal to manage your companies True View Point balance, 

during the Create Post Process Trajectory step. To allow this communication to happen, your company 

specific True View Reckon Portal URL must be entered in EVO on the True View tab (Figure 3). Use the 

instructions below to add your company specific URL to EVO. 

1. Open the True View tab on the Project Settings dialog (File>Project Setting>True View tab) 

2. Click the Green plus sign next to the True View Company Settings field. A new row should be 

available. 

3. Double-click in the Company Name field and enter the name of your company. 

4. Double-click in the Company URL field and enter the specific True View Portal URL for your 

company. This URL should have been provided in the EVO license email you received after 

purchase. 

5. Once the company name and company URL have been entered (Figure 3), click apply and close 

the dialog. EVO is now configured for cloud processing.  

 

Figure 3 – True View Company Settings 

TRUE VIEW RECKON PORTAL 
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True View Reckon Portal is the site where GeoCue manages your company’s True View Points and 

sensor calibration. True View portal also allows your company admin to add users who can use your 

company’s True View Points for processing. The steps below describe how to add users to you True 

View Reckon portal account. 

1. GeoCue creates your company’s True View portal account and creates the Company specific 

URL. The URL should be https://airgon.net/ with your company’s name, abbreviation, or domain 

at the end. 

i. Example: https://airgon.net/CompanyABC 

2. GeoCue will assign someone from your company as the point of contact to your company’s 

account. This person will be the administrator of your True View Portal account and will be 

responsible for adding additional users who are allowed to process using True View Points. The 

point of contact will receive an email after purchase which contains the company URL and login 

credentials.  

3. The company point of contact will login to the True View Portal account where they will add 

additional users. Click the Users tab (Figure 4) and click “+ New User” at the bottom right corner 

of the page. 

 

Figure 4 – True View Reckon Portal 

4. Enter the new user email address and assign the appropriate permission for this user (Figure 5). 

Users can have multiple roles.  

a. Administrator - Administrators have full access to a company site. They can add, delete 

and edit users, and establish groups. They also can customize a company’s site by adding a 

company logo. 

b. Editors - An editor has access to the Redline functionality of Reckon. Redlining provides 

the ability to create, edit, and publish geometries with attributes. Redlines can be used to 

communicate work to be done with a service provider (i.e. defining boundary area for data 

to be acquired from vendor), edit existing features, create new features, and download as 

ESRI shape file for use in other applications. 

c. TrueViewProcessing - This role is only available to accounts associated with a True View 

system. A user with this role has access to use a company’s True View Points. 

https://airgon.net/CompanyABC
https://support.geocue.com/add-reckon-user-for-true-view-processing/
https://support.geocue.com/add-reckon-user-for-true-view-processing/
https://support.geocue.com/create-redline-reckon/
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Figure 5 – Adding a new user in True View Reckon Portal 

5. Click save and the new user account details are displayed on the screen.  

6. An email can be created and sent to the new user, or the details can be copied to clipboard, and 

pasted in a document or email that can be sent to the new user. 

a. The password can be reset by the user by accessing the company URL and using the 

Forgot Your Password link on the login page (Figure 6). 

 

Figure 6 – True View Reckon Portal Login 

LOCAL 

POSPac local processing is a method available only to those who have purchased their True View 

system and have POSPac UAV installed and licensed on their machine. A POSPac UAV network license 

allowing for single base processing only is included with a True View system purchase. Subscription 

systems and processing using SMARTBase or PP-RTX, must use POSPacCloud. EVO will execute a 

batch process in the background using the local version of POSPac. Use the steps below to configure 

EVO for use with a local version of POSPac UAV. 

https://support.geocue.com/single-base-vs-smartbase-vs-pp-rtx/
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CONFIGURING EVO FOR POSPAC UAV 

1. Install POSPac UAV to your machine and activate your POSPac UAV license. See Appendix A: 

POSPac UAV Network License for more information on activating and using your   

2. Open EVO and click File> Project Settings>True View tab. 

3. The file path under POSPacBatch.exe Location (LOCAL) should be auto populated (Figure 7). If 

the file path is empty, navigate to C:\Program Files\Applanix\POSPac UAV 8.4\ and select 

PospacBatch.exe. Click apply when finished.  

 

Figure 7 – True View POSPac Settings 

4. EVO should now be configured to use POSPac UAV.  
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CREATING A NEW EVO PROJECT 

The following steps will guide you through each step of the workflow, from importing your raw data to 

generating a LIDAR point cloud and tagging photos. 

1. Open True View EVO and check out your license if necessary. See Licensing True View EVO. 

2. Insert the UMS drive which contains your cycles (raw flight data). 

3. In the View menu, ensure the True View Workflow and True View Utilities toolbars (Figure 8) are 

selected. 

  

Figure 8 – True View Workflow and Utilities Toolbars 

4. Select Import True View Cycle into LP360 Project  on the True View Workflow toolbar to 

open the Import Cycle dialog. If the Import True View Cycle button is greyed out, then you do 

not have a valid True View EVO license checked out. See Licensing True View EVO. 

 

Figure 9 – Import Cycle 

IMPORT CYCLE 

5. Populate the import dialog with the appropriate information based on your project. Figure 10 

corresponds to the items in the Import Cycle dialog: 

a) True View Projects Folder – Select a location for all True View EVO projects to be 

created. A project folder will be created in this folder with the name provided in step b). 

b) Project Name – Enter a name for the project.  

c) Area Name (Optional)- Projects can be divided into areas. A subfolder will be created 

with the area name and the area name prepended to layers created from Cycles for that 

area. Select from the dropdown if importing into an existing project, or select  to 

add an area name. 

d) Include Archive cycles in Cycle list – Cycles in the selected folder will be displayed in 

Available Cycles (item i).  

e) Base Station Observation File – Import the base station RINEX file by selecting  

beside the list box. The start and stop time of the file is displayed in the dialog. Note: 

Only RINEX observations are supported at this time. 
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f) Recent Spatial Reference Systems (SRS)– Recently used spatial reference systems will 

be displayed here and can be quickly selected from the drop-down menu. If the one you 

need is not shown here, use the ellipse button  in step g). 

g) Spatial Reference System – Displays the WKT coordinate system definition. Select the 

ellipse button  to open the SRS library and select a horizontal and vertical SRS.  

h) Cycles – Check the box next to each Cycle to be imported into the project. 

i) Available Cycles – The large box at the bottom of the dialog shows all Cycles 

recognized on the UMS drive, and all Cycles in the Archive folder selected in step d). 

Information about each cycle, such as time, system serial number, and image count will 

be displayed in the dialog. 

j) Add Cycle to List  – Allows the user to manually add a 

single Cycle to the Available Cycles list by navigating to and selecting the Cycle folder.  

k) Refresh  – Refreshes the available Cycles list. If the UMS drive is 

inserted after opening the Import Cycle dialog, selecting Refresh will have EVO search 

again for an external storage device with Cycles.  

l) Import  – Once all items have been filled out, select Import to 

create the project, if importing for the first time, and import the data into the project 

and area folder. 

 

Figure 10 – Import Cycle 
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EXAMINING IMPORTED FILES 

6. After the import is complete, the flight files will be displayed in the map view of EVO. A WMS 

layer will be displayed behind the data so the user can see approximately where flight path 

occurred (Figure 11). The white box on the left side of Figure 11 is the Table of Contents (TOC), 

the map area on the right is referred to as the Map View. Each layer in the TOC is named after 

the Cycle date and time, with a name appended to the end that represents the type of 

information contained in the layer, and prepended by the Area Name. A layer can be selected 

by left clicking on the desired layer until it is highlighted. Once selected, right-click the layer 

and select Feature Analyst to open the Feature Analyst dialog (Figure 12) to review the 

attributes of features on the layer. 

a) Station Layer – This layer contains information about photo stations. Click on a station 

in feature analyst to view the photo pair (Figure 12). The photo pair should be displayed 

in feature analyst and the station should be highlighted in the map view. Check the 

images to verify correct exposure.  

b) Photos Layer – This layer contains information about each photo and photos can be 

viewed in feature analyst. 

c) Trajectory Points Layer – These points are time synced with the trajectory file and are 

used to created flight lines, which we will use later to define each line of LIDAR data.  

d) Log Points Layer – True View Sensors collect information about the status of 

operations throughout the flight.  This log file is a simple text file stored within the 

Cycle directory. You can examine the entire log by right clicking the LogPoints layer in 

the table of contents and selecting Feature Analyst.  Like all data in Feature Analyst, 

you can drive the log to a specific entry by selecting a point in the Map View. Each entry 

within this file has a time tag.  During import of a Cycle, the log file is correlated with 

the Trajectory Points data and spatially displayed as a layer in the TOC. The log file can 

provide valuable insight into sensor operations (voltages, temperatures) as well as 

diagnostics when something goes wrong. 

e) Trajectory Line Layer – Shows the real-time trajectory from the beginning to the end 

of the file.  

f) WMS Layer – A WMS backdrop layer, such as Google Hybrid allows the user to check 

the flight for coverage and rough location. 

g) Layer toggle On/Off – Each layer can be toggled on/off and viewed independently by 

toggling the checkbox next to the layer.  

h) Layer in Map – Each layer is plotted on the map view as shown in (Figure 11) in the order 

they are listed, form top to bottom, in the TOC. 
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Figure 11 – TOC and Map View 

 

Figure 12 – Feature Analyst 

CREATE POST PROCESS TRAJECTORY FILE 

After the data has been imported and the files have been examined, the next step is to correct and fuse 

the GNSS and inertial data by running the tightly integrated Applanix POSPacCloud (cloud), or POSPac 

UAV (local). This step is named Create Post Processed Trajectory and will create a single text file with 

the corrected position and orientation of the entire flight, along with a POSPac QC Report. 

1. Open the Create Post Process Trajectory File dialog by selecting the  button on the True 

View Workflow toolbar (Figure 13). 

 

Figure 13 – Create Post Process Trajectory File 
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PROCESSING SETTINGS SELECTION 

2. The Create Post Process Trajectory File dialog (Figure 14) should now be opened to the first 

page, which is where the user will select the file to be processed, and how it will be processed. 

The bullets below explain the settings for the Create Post Process Trajectory File dialog 

(Figure 14). 

 

Figure 14 – Create Post Process Trajectory File 

a) Cycle Name – Select the Cycle for which to process the trajectory. All Cycles that were 

imported into the project will be visible in the dropdown. Each Cycle will need to be 

processed separately. 

b) Raw Position File – This shows the path to the T04 file contained in the cycle that was 

selected in step A. Each cycle will have a different T04 file. 

c) POSPac Run Location – Select to process Local or Cloud by selecting the applicable 

radio button next to the option. 

d) Login – If the Cloud processing option was selected: Select your company (See Adding 

a Company to EVO) from the dropdown; Enter your True View Reckon Portal email and 

password, and press tab to connect to True View Reckon Portal. The word “Password” 

will be red initially but will turn black after a successful login.  

e) POSPac Processing Mode – Choose the processing method to be used to correct your 

GNSS and inertial data. If the POSPac run location is set to Local, single base is the only 

option that can be used.  

i. Single Base ($) – Uses the RINEX file recorded from a single base station. 

ii. Smart Base ($$) – Uses the SmartBase network from Applanix. 

https://support.geocue.com/single-base-vs-smartbase-vs-pp-rtx/
https://support.geocue.com/applanix-smartbase/
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iii. PP-RTX ($$$) – Uses the PP-RTX solution from Applanix. This is the least 

accurate option and should be used only if single base and SmartBase cannot 

be used. 

f) Cycle Summary – Contains information about the sensor and start/end time of the T04 

file. The True View account balance will be displayed, if enabled, along with the 

estimated cost to process this cycle using the selected method. “Duplicate Task” will be 

shown if the process has already been run successfully using the same method and 

indicates no additional True View Points will be charged. 

3. Select Next to move to the next page of the dialog. If using single base as the processing mode, 

the next page will be the base station input page (Figure 15). If using Smart base or PP-RTX, the 

next page will be the Trajectory Output Settings. 

BASE STATION INPUT SETTINGS 

4. The Base Station Input page only appears when processing using the single base option. The 

bullets below correspond to Figure 15. 

a) Base Station Observation File(s) – This field should be populated automatically if the 

base station RINEX file(s) was imported during the Import Cycle step. If not, it can be 

imported here by selecting  to the right of the grid. If the Antenna type was 

written to the RINEX header, it will automatically be recognized and displayed in this 

box. If not present, the RINEX file should be edited to include the information and 

added anew. 

b) Base Station Manager – This allows the user to save coordinate information in steps c), 

4.d), and 4.e), and select them from the dropdown menu for future processing. If the 

coordinate has not been previously saved, complete steps c), 4.d), and 4.e), and select 

the save icon  on the right side of the Base Station Manager. 

Import, Export, and Delete are also available for managing the saved base stations and 

moving them around between processing machines. 

https://support.geocue.com/applanix-pp-rtx/
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Figure 15 – Base Station Input 

c) Location – Enter the Latitude, Longitude, and Ellipsoid height in meters. Be sure to 

separate the Degrees, minutes, and seconds, with a colon (DD:MM:SS.sssss).  

i. If an OPUS solution is being used, save the OPUS results in a simple text file 

and import into EVO using the Load OPUS button. The Lat, Lon, and ellipsoid 

elevation will be automatically read from the text file and populated in the 

applicable fields.  

ii. If the coordinates are provided in decimal degrees, check the Decimal Degrees 

option box before entering the coordinate. 

d) Antenna Height - Enter the base antenna height from the measured mark to the 

Antenna Reference Point (ARP). Phase center offsets should not be added to the 

antenna height, unless the base antenna model was not written to the header and 

recognized in Base Station Observation section (item A). 

e) Frame – Choose the correct reference frame and epoch for the base station coordinate. 

i. Plate model velocity calculations can be omitted by unchecking the box, if 

needed. 

f) Select Next to move to the.Trajectory Output Settings 
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TRAJECTORY OUTPUT SETTINGS 

5. The Trajectory Output Settings page is used to define the output spatial reference system 

(SRS) and units for the processed trajectory file. The bulleted points below correspond to Figure 

16. 

a) Frame – Select the desired grid, zone, and datum of the trajectory file that will be 

created. The datum will default to the default datum of a zone, so be sure to set it last. 

b) Height Options – Choose the desire output vertical datum. 

i. Ellipsoid – Output height values will be referenced to the ellipsoid of the target 

mapping frame’s datum. 

ii. Orthometric – Output height values will be adjusted using the selected geoid 

model. 

c) Target Epoch - Select the desired target Epoch. The default is based on the datum of 

the selected mapping frame. 

d) Output Units – Choose the desired output units to match the project. 

 

Figure 16 – Trajectory Output Setting 

6. Select Next to move to the Processing Confirmation page. 

It is very important to select a spatial reference system (SRS) from these Applanix 

options that match the project SRS selected during project setup. If one does not 

exist, select a common project SRS and then use the Reproject LAS PCT to reproject 

the final LAS files to the desired final SRS at the end of processing. 



True View EVO Users Guide 
 

20 True View EVO v2020.1.71.0 and later    5/11/2020 

PROCESSING CONFIRMATION 

7. The Processing Confirmation page contains information about the sensor and processing 

times. The bullets below correspond to Figure 17. 

a) Review Current Settings – Contains information about the hardware, software, and 

cost estimates. 

b) Results – After trajectory processing is completed successfully, contains information 

about the results of the processing, included the actual cost, if applicable.  

 

Figure 17 – Processing Confirmation 

8. Select Submit when ready to submit the data for processing.  

9. You will be prompted with a message asking you to confirm your submission. Click Ok.  

 

Figure 18 - Run POSPac Confirmation 

10. Once complete, you will be prompted to view the POSPac report. Click Yes to view the report, 

or No to move to the next step. You may reopen the POSPac report at any time by selecting 

 on the True View Utilities toolbar. 

11. The results of this process will be corrected position and orientation, which will be saved in a file 

named PostProcessedTraj.txt located in the POS folder in the EVO project folder. 
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POST PROCESS TRAJECTORY TROUBLESHOOTING 

When POSPac is not successful in producing the trajectory you may see a few generic error messages 

indicating the failure. 

TRUE VIEW ERROR: UPLOAD_FAILED 

 

Figure 19 - True View Error: Upload_Failed 

True View EVO is experiencing problems packaging and uploading the POS data to the POSPacCloud. 

Verify your internet connection is stable and try again. Otherwise, see the probable resolutions on our 

searchable support knowledge base. 

TRUE VIEW ERROR: EXECUTION_FAILED 

 

Figure 20 - True View Error: Execution_Failed 

This generic error message occurs whenever POSPacCloud fails to produce a smoothed GNSS-Inertial 

solution. The number one reason is an incorrectly entered base station coordinate. West and South 

coordinates must be entered as negative values.  

Locate the “YYMMDD_HHMMSS.log” file from the 

Area_\Cycle_YYMMDD_HHMMSS\POS\POSPac_YYMMDD_HHMMSS folder corresponding to the 

attempted execution in POSPacCloud and review the contents for the messages in the reason section. 

Refer to the probable resolutions to those reasons on our searchable support knowledge base. 

https://support.geocue.com/upload_failed/
https://support.geocue.com/upload_failed/
https://support.geocue.com/execution_failed/
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TRUE VIEW EVO ERROR: AN UNEXPECTED ERROR OCCURRED RUNNING 

POSPACBATCH.EXE 

 

Figure 21 - Unexpected Error running POSPac UAV 

This generic error message occurs whenever POSPac UAV (local) fails to produce a smoothed GNSS-

Inertial solution. The number one reason is an incorrectly entered base station coordinate. West and 

South coordinates must be entered as negative values. 

Open the \POS\POSPac_YYMMDD_HHMMSS\YYMMDD_HHMMSS.log file and review at which stage 

the processing failed. Refer to the probable resolutions to those reasons on our searchable support 

knowledge base. 

  

https://support.geocue.com/unexpected-error-occurred-running-pospacbatch-exe/
https://support.geocue.com/unexpected-error-occurred-running-pospacbatch-exe/
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CREATING FLIGHT LINES AND TRUE VIEW TRAJECTORIES 

The steps to this point have allowed us to create a single text file with the corrected trajectory of the 

entire Cycle. Sections of each flight in the Cycle are not useful to us, such as the IMU heading alignment 

maneuver and flight line transitions, so we clip these sections out by defining which portions of the 

flight to keep. Usually only the data collected along the flight lines are retained, so we will use the Auto 

Create Flight Lines tool   from the True View Workflow toolbar (Figure 22) and the Create Flight 

Lines from Selected Trajectory Points  from the True View Utilities toolbar (Figure 23) for the next 

step. Flight lines are created using the time in the trajectory points layer, then a new layer is created 

named “Area_YYMMDD_HHMMSS_Flight lines”. The steps below describe how to create flight lines 

automatically and manually. The best approach is to create flight lines automatically, then add or 

delete flight lines manually to get the exact flight lines we want.  

 

Figure 22 – Auto Create Flight Lines 

 

Figure 23 - Create Flight Lines from Selected Trajectory Points 

AUTO CREATE FLIGHT LINES 

1. Select the Auto-Create flight lines tool on the True View Workflow toolbar (Figure 22) to open 

the Auto Create Flight Lines dialog (Figure 24). 

a) Trajectory Point Layer - Auto populated, but can be selected if multiple Cycles were 

imported. 

b) Flight Line Layer - The name of the layer that will be created and requires no input 

from the user. 

c) Min. Length – No linear set of points shorter than this value will be considered for the 

calculation of a flight line. This number should usually be set to the shortest flight line 

length. Use the Measure tool  on the LP360 Navigation toolbar to measure the 

shortest desired flight line. 

d) Turn Radius – The radius, in map units, to allow at turns. The smaller the number, the 

closer the flight lines will be cut to the turns. The greater the radius, the larger the gap. 

e) Max Deviation – The deviation parameter that tells the software when to break a line 

segment into two. The smaller this number, the more linear the flight lines but the 

more flight lines that will be created. The larger this value, the more “bend” will be 

allowed in a relatively straight segment without splitting. Hence, open up this value if 

you have curved flight lines. 
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Figure 24 – Auto Create Flight Lines 

2. Once you have entered the desired parameters, select Compute Flight Lines. 

3. The flight line layer should be created, and the flight lines displayed in blue in the map view. 

a) Results can be changed by changing the parameters and selecting Compute Flight Lines 

again. The existing lines will be replaced with the results from the new settings. 

4. Flight lines can be deleted if necessary, by selecting the layer with the Select/ Edit Features 

button Error! Reference source not found. and clicking the red “X” on the feature edit tool bar.  

a) Select the Select/ Edit Features tool   on the LP360 Feature Edit toolbar (Figure 

25) 

b) Select the flight line you wish to delete, and the line will be highlighted (Figure 26). 

i. If multiple feature layers are selected, you will be prompted to choose a layer. 

Choose the flight line layer. 

ii. Hold control while selecting to select multiple flight lines. Or, drag to select 

multiple flight lines. 

c) Select the Delete Selected Features  button on the LP360 Feature Edit toolbar 

(Figure 25) and the selected feature(s) will be deleted. 

d) Delete all unnecessary flight lines. Undo  and Redo  may be used if you 

accidentally remove the wrong flight line. 

e) Select the Save Feature Edits  icon on the LP360 Feature Edit toolbar (Figure 25)  to 

save the edits. 

 

Figure 25 - LP360 Feature Edit toolbar 
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Figure 26 – Editing Flight Lines 

MANUALLY CREATE FLIGHT LINES 

1. Flight lines can be added manually by selecting trajectory points (red points) at the beginning 

and end of each line. 

a) Select the Select/ Edit Features tool   on the LP360 Feature Edit toolbar (Figure 

25). 

b) Select a trajectory point at the beginning of the desired flight line. The point will be 

highlighted when selected.  

c) Hold control, then select a trajectory point at the end of the flight line. Both trajectory 

points should now be highlighted (Figure 27).  

 

Figure 27 – Manually Creating Flight Lines 



True View EVO Users Guide 
 

26 True View EVO v2020.1.71.0 and later    5/11/2020 

d) Select Create Flight Lines from Selected Trajectory Points  on the True View 

Utilities toolbar (Figure 23) and a new flight line should be created.  

e) Select the Save Feature Edits  icon on the LP360 Feature Edit toolbar (Figure 25)  to 

save the edits.  

Note: If you select Trajectory Point patterns that do not form the required base for creating a 

flight line, you will receive an error message that explains the issue (Figure 28).   

 

Figure 28 - A pattern of Trajectory Points not compatible with forming a flight line 

CREATE TRUE VIEW TRAJECTORIES  

1. Once flight lines have been created, and the edits saved, select Create True View Trajectories 

  from the True View Workflow toolbar (Figure 29). The purpose of this step is to use the 

flight line layer to create a reduced trajectory file from the PostProcessedTraj.txt file for each 

flight line.  

 

Figure 29 - Create True View Trajectories 
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Figure 30 - Create True View Trajectories dialog 

2. These fields of this dialog are usually auto populated if only processing a single Cycle and the 

post process trajectory solution was successful. 

a) Flight Line Layer - Select the flight line layer from which to generate True View 

trajectories if multiple Cycles are being processed.  

b) Post Processed Trajectory File – The trajectory file generated by POSPac. A post 

processed trajectory file may also be imported here if have one from a previous 

processing session with the same data. 

c) Starting Point Source ID – When there are multiple Cycles or flights in a project it is 

important to assign unique point source ids, or flight line numbers to each line. 

Selecting a unique starting ID allows the user to determine the best values between 1 

and 65535 to use for each line. 

3. Select Create Trajectories to create True View trajectories for the selected Flight Line layer. 

Repeat for each Cycle as applicable. Close the dialog when finished. 

If you cannot remember if you have run the Create Trajectories step, there is no harm in running it 

multiple times. If you want to confirm creation of the flight line trajectories, you can inspect the 

Flight Line attributes using the True View Evo/LP360 Feature Analyst tool. Right-click the Flight 

Line layer in the TOC and then left-click “Feature Analyst …” (see Figure 31). 
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Figure 31 - Opening Feature Analyst on the Flight Line layer 

Observe the “TVTrajFIle” column in the Feature table of Feature Analyst (Figure 32). If this column 

is blank, flight line trajectories have not yet been created.   

 

Figure 32 - True View Flight Lines prior to assigning Trajectories 

Figure 33 shows the feature table after creation of the True View Flight Line trajectories. Note a file 

location is now populated in the TVTrajFile attribute column.   
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Figure 33 - True View Flight Lines after assigning Trajectories 

Note: The Flight Line Trajectory files created in True View EVO for 3D Imaging Sensors (3DIS) are in 

Terrasolid trajectory format. These trajectories can be directly used in products such as TerraScan 

and TerraMatch.   

GEOCODE LIDAR 

The Geocode LIDAR step is where the raw data in the laser.bin file is geocoded using the True View 

trajectory file, creating a spatially accurate 3D point cloud. The steps below explain the functions of the 

Geocode LIDAR dialog. True View trajectories must have been generated before the geocode LIDAR 

tool will be active. 

1. Select the Geocode LIDAR button  on the True View Workflow toolbar (Figure 34) to open 

the Geocode LIDAR dialog. 

 

Figure 34 – Geocode LIDAR 

2. The Geocode LIDAR dialog (Figure 35) is where the user will select the calibration file, and 

LIDAR clipping settings. A 3D point cloud, LAS files, will be generated after completing this 

step. 

a) Flight Line Layer – The layer that will be used to geocode. 

i. Only Use Selected Flight Lines – This option allows the user to select a flight 

line using the Select/ Edit Features tool   on the LP360 Feature Edit 

toolbar (Figure 25), then geocode LIDAR for only the selected flight lines. If 

geocoding LIDAR for all flight lines, leave this box unchecked. Note: Geocoding 

all flight lines (unchecked) will delete all LAS files if they existed for these lines. 
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Figure 35 – Geocode LIDAR dialog 

b) Calibration file – The True View 410 sensor calibration is critical to get accurate LIDAR 

data. Select the option for the calibration file you wish to use: 

i. Use Latest Calibration File (Recommended) – The latest calibration file for 

your sensor is stored on True View Reckon portal. When this option is selected, 

EVO will use the latest calibration file found on True View Reckon portal to 

process your data. This is the recommended option as some smarts exist on 

Reckon to help ensure the correct calibration file for the system. 

ii. Use Current Calibration File – If this option is selected, the calibration file in 

the system folder of Cycle will be used to process the data. This may not be the 

latest calibration file if updates to your calibration have been made and those 

updates were not copied to the UMS prior to acquisition. 

iii. Manually Select Calibration File – This choice will invoke a dialog that allows 

you to select a file from all available calibration files for this sensor from 

Reckon. If you select this choice, the dialog of Figure 36 will be displayed when 

you press the Geocode LIDAR button at the bottom of the Geocode LIDAR 

dialog. You can pick the calibration file you desire using the dropdown picker.   
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Figure 36 - Calibration File Picker 

c) Clip Angle – Enter the processing angle in degrees. This number represent the half 

angle off Nadir of the scanner. If 40 is entered, LIDAR data will be geocoded if it falls 

between +40° and -40° creating a total field of view (FOV) of 80°. 

d) Clip Range – Enter the maximum range to be geocoded. No points with a range greater 

than this value will be geocoded. Useful when no Clip Angle is used to pick up features 

beside the system. 

e) Enable True Track® – True Track® is our term for software-enabled roll compensation 

of the senor.  The roll attitude of the sensor (due to roll of the drone carrying the 

sensor) is constantly reset to the nadir position and clipping (if set) applied at this point.  

The effect is flight lines with straight rather than wavy edges.   

You should always enable True Track.  For a given clipping angle, it will produce more 

accurate as well as better aligned data.  Figure 37 shows a LIDAR swath clipped to 20° 

but with True Track disabled.  Notice the waviness in the sides of the track. 

 

Figure 37:  LIDAR Strip without True Track 

Figure 38 shows the same swath, again clipped to 20°, with True Track enabled.  Notice 

how the edges of the swath are now relatively straight. 

 

Figure 38:  LIDAR Strip with True Track enabled 

f) GeoCode LIDAR – LIDAR data will be geocoded when this button is clicked, creating 

the LAS layer for the selected Cycle. 

3. Close the dialog when finished. 
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COLORIZE POINT CLOUD 

Colorize Point Cloud  on the True View Workflow toolbar (Figure 39) uses the photos to colorize 

each point in the point cloud. The colorization of the point cloud will depend on the quality of the 

photos. If colorization is critical to the project, it is recommended to check the photo quality in the field 

prior to leaving the site. 

1. Select Colorize Point Cloud  on the True View Workflow toolbar (Figure 39) and the colorize 

point cloud dialog (Figure 40) will open. 

 

Figure 39 

 

Figure 40 

2. The photo layer that will be used to colorize the point cloud should be auto-selected, but 

different layers can be selected if multiple Cycles were imported into the project. 

3. Select Colorize Point Cloud on the dialog and the point cloud will be colorized. Close when 

finished. 

Colorizing the point cloud is a more time-consuming process than Geocoding. Processing status will 

be displayed in the lower left section of the True View Evo/LP360 main window frame and swaths 

will be loaded in the Map View, with Display by Color enabled, as they complete processing.  An 

example of a colorized point cloud from a True View 410 3DIS is shown in Figure 41. 
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Figure 41:  A colorized True View 410 Point Cloud 
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UPDATE EXIF TAGS FOR PHOTOGRAMMETRIC SOFTWARE 

Update EXIF Tags   on the True View Utilities toolbar (Figure 42) will tag each photo with the 

corrected position and accuracy value. Photos that were taken outside of the corrected trajectory file, 

such as photos on the ground before takeoff, will be removed. This utility must be run to use the 

images in Metashape, Pix4D and other photogrammetric packages with similar workflows. 

 

Figure 42 – Update EXIF Tags 

1. Select Update EXIF Tags on the True View Utilities toolbar (Figure 42) to open the Update EXIF 

tags dialog (Figure 43). 

 

Figure 43 - Update EXIF Tags dialog 

2. The photo layer that will used to update the EXIF tags should be auto populated. Different 

layers can be selected if multiple Cycles were imported. 

3. Select Update EXIF Tags to tag the images.  

4. A confirmation dialog will appear showing the number of images that will be removed. This is a 

result of those images being outside of the corrected trajectory time frame and normal for the 

tagging process. Select yes to continue. 

5. When the process is complete, select OK on the confirmation dialog. 

6. The images from both cameras are now tagged. 

a) Tagged images, suitable for Metashape, are in the project folder, in the Port and 

Starboard folders (Figure 44) (EVO project\Area_\Cycle_YYMMDD_HHMMSS\Flight_ 

YYMMDD_HHMMSS\) 

 

Figure 44 – Example Location of Tagged Images 
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b) Two CSV files with the image positions are created in the System folder in the same 

location (EVO project\Area_\Cycle_YYMMDD_HHMMSS\Flight_ 

YYMMDD_HHMMSS\System) 

i. The CSV file named “Image_geo_eo.csv” (Figure 45) contains the image 

positions in geographic coordinates, height in meters. The orientation angles 

are yaw, pitch and roll in degrees. 

ii. The CSV file named “Image_proj_eo.csv” (Figure 45) contains the image 

positions in projected coordinates, height in project units. The orientation 

angles are yaw, pitch and roll in degrees. 

iii. The CSV file named “image_geo_opk.csv” contains the image position file in 

geographic coordinates, height in meters, with the orientation angles 

represented as omega, phi, kappa in degrees. This file is configured to be used 

in Pix4D. 

 

Figure 45 – Example Location of Image Position Files 

c) Camera calibration files are also created for each camera in EVO 

project\Area_\Cycle_YYMMDD_HHMMSS\Flight_ YYMMDD_HHMMSS\System folder 

(Figure 46). 

i. The xml files named Port.xml and Starboard.xml can be directly imported into 

Metashape. 

ii. The text files named PortP4D.txt and StarboardP4D.txt can be used in Pix4D. 

 

Figure 46 – Example Location of Camera Calibration Files 
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APPENDIX A: POSPAC UAV NETWORK LICENSE 

A purchased True View system comes with one set of Applanix Network POSPac UAV licenses (POSEO, 

MMS_GNSS-Inertial_QC, and UAV GNSS-Inertial) for post processing the trajectory solution from 

within EVO. POSPac provides a user with the capability to use a software license within a shared 

network environment running a license management service included with the POSPac installation. 

Hence, is best to activate this license on a machine which can act as the License Server on your 

company network. Other computers on the same network will automatically borrow the license when 

needed and return it when done. If needed, you may also borrow the licenses from the server to a 

laptop to take to the field for processing while disconnected from the license server. 

Let’s say you activated your license on Computer A.  

• The license now resides on Computer A  

• The license CANNOT be activated again on any other computer  

• Each license can ONLY be activated on a single computer  

• Trying to activate the same license will yield a “All activations have been exhausted for this 

entitlement” like shown here  

 

Figure 47 - POSPac Software License Utility 

Now, any computers that are on the same network as Computer A will be able to USE the license 

residing on Computer A. No configuration is usually necessary, but see the Firewall Settings to 

Communicate with the License Server below if the Applanix Software License Utility on the other 

computers do not automatically see the licenses on the License Server after activation. 

• The license still resides on Computer A  

• Other computers on the same network as Computer A will automatically borrow the license 

when needed  

There are some steps to ensure this feature is working properly.   
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ACTIVATE THE LICENSE SERVER 

When you have selected the machine to act as your Applanix License Server, install POSPac UAV if you 

wish to use it to also process data on the same machine. Otherwise, install only the Applanix Software 

License Utility 8.4 SP1 Hotfix Official, also available from the POSPac folder on our FTP site. 

POSPac supports online activation of software licenses. Activation can be accomplished entirely by the 

user, provided they have internet access and an Applanix-provided Entitlement ID (EID). 

POSPac provides a utility for managing software licenses. The Software License Utility can be run from 

the POSPac Help menu or the Windows Start Menu under the All Programs -> Applanix -> 

SoftwareLicenseUtility menu.  

1. Open the Applanix Software License Utility (SLU) 

2. Select Activate License (internet access is required) 

 

Figure 48 - Online Activation 

3. In the dialog, enter the POSPac Entitlement ID provided with your True View licensing 

information. 

4. If necessary, configure the Firewall Settings to Communicate with the License Server. 

TO USE THE LICENSE WHILE ON THE SAME NETWORK AS THE LICENSE SERVER 

1. The computers on the network will have to point the License Server (in the Software License  

Utility (SLU)) towards Computer A. We will name this computer, Computer B, for clarity-sake.  

First, find the host name of Computer A (you can run ipconfig /all in the Command Prompt). 

Then go into the License Server inside the SLU on Computer B and add the host name of 

Computer A. It will look something like this. Make sure to save after adding the name.  
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Figure 49 - License Servers 

2. Now, if you look at the SLU on the Computer B, you should see the licenses that are on 

Computer A. Note that it says on the bottom “Found license manager running on APPL-

ENG001696”. This should now be the host name of Computer A if done correctly.  

 

Figure 50 - SLU - Licensed 

  

3. The above procedures are for computers on the same local network  
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TO BORROW A LICENSE FROM THE LICENSE SERVER 

1. Now, say you have a laptop on the network, and you wish to take this laptop out in the field 

but still want to use POSPac for processing. In this case, you can check-out the license (you are 

essentially borrowing the license from Computer A)  

 
2. Open the SLU on the laptop. You can then Select the licenses you want to borrow, set the 

Commute days, then select Check Out Selected.   

 

Figure 51 - Commute Licenses 

3. Once you do this, the license on Computer A will temporarily move to the laptop for the set 

number of days. Note that when you do this, Computer A will act as if there are no licenses on 

it and therefore the computers on the network will not be able to see and use the licenses. 
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Once the set number of days has passed, the license will automatically be recalled to 

Computer A  

4. You can remove the laptop from the network and still be able to use the license  

5. You can also return the license back into Computer A whenever the laptop is on the same 

network again. 

 

Figure 52 - Check in Commuted License 

FIREWALL SETTINGS TO COMMUNICATE WITH THE LICENSE SERVER 

If either your License Server or workstation have a firewall in place, then exceptions will need to be 

made to allow for the license communication through the firewall. Make the exceptions on all machines 

with firewalls in place. 

 In the Windows Defender Firewall Advanced settings add the following inbound rules: 

• Allow the program “C:\Program Files 
(x86)\Applanix\SoftwareLicenseUtility\ Applanix.SoftwareLicenseUtility.exe” 

• Allow TCP port 5093 
• Allow UDP port 5093 

 In the Windows Defender Firewall Advanced settings add the following Outbound rules: 

• Allow the program “C:\Program Files 
(x86)\Applanix\SoftwareLicenseUtility\ Applanix.SoftwareLicenseUtility.exe” 

• Allow TCP port 5093 
• Allow UDP port 5093 

 

CONFIGURING THE APPLANIX SOFTWARE LICENSE UTILITY FOR VPN 

In some instances, you may wish to use the license while remote, but can connect to the License Server 

via a VPN connection. First, ensure both the License Server and your computer have configured 

applicable Firewall Settings to Communicate with the License Server. 

1. Connect to your office network via VPN. 
2. Open the Applanix SLU on your computer 
3. If it doesn’t find any License Server, select License Server 
4. Type the name of your License Server in the top bar 
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5. Select Add 
6. Select Save 
7. Close the License Server dialog 
8. Close the SLU dialog 
9. Open the SLU and now it should find the license manager running on the License Server 

 

Figure 53 – SLU – Licensed from Server 

From that point forward, you should only have to connect to the VPN. Then, execute the post 

processed trajectory processing from within True View EVO and the license will borrow akin to being on 

the network.  

APPLANIX SOFTWARE LICENSE UTILITY TROUBLESHOOTING 

NO INTERNET CONNECTION AVAILABLE. ACTIVATING A LICENSE REQUIRES AN 

INTERNET CONNECTION. 

 

Figure 54 - No Internet Connection Available 

The Applanix license activation and deactivation uses HTTP/HTTPs protocol to communicate with their 

license server web portal, server at licensing.applanix.com (HTTP Port 8080, 31350, SSL Port 8443).  

On bootup, the Software License Utility attempts to connect to ftp.applanix.com. You will need to 

ensure that the Software License Utility and Sentinel RMS License Manager are not being blocked by 

any firewalls.   

ftp://ftp.applanix.com/
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SUPPORT 

Normal support business hours are Monday - Friday, 8 AM — 5 PM USA Central Time. 

If a support request is sent during business hours a representative will typically get back to you within 4 
hours. If received after hours, a response will be sent the following day. To speed response time please 
include the following information in your request: 

• Contact information - please include e-mail address and phone number 
• Company name 
• Product name and version number 
• True View Model and Serial Number 

If your request includes problems pertaining to a specific error message, please include a screen shot of 
the error message. 

For hardware and software support contact: 

support@airgon.com 

file:///C:/Users/mstevens/Downloads/support@airgon.com
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